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I n t r o d u c t i o n

I N T R O D U C T I O N

Intelligent and seamless interfacing to the outside world is the key to success in
many intercom applications. Connect Solo interfaces your intercom system via an-
alogue telephone connections to PSTN public telephone networks.

Connect Solo combines two independent analogue POTS telephone hybrids in
one halfrack/1U device. One unit – two hybrids: This saves rackspace and is a val-
uable advantage, especially for mobile production units. 

The system has analogue as well as digital AES/EBU Audio interfaces.

The configuration of the system can be carried out via the Windows application
included in delivery or via the front keypad of the unit.

English
Deutsch
Menu
Select
System Settings
System Settings
Language
Language
Cap
Ok
Save settings?
Yes
No
Operation Settings
Select
Line Mode
POTS
Audio
Audio Settings
Audio
Audio interface in
Audio interface out
Analogue
Digital
PRETALK Interface
No system
Telephone
Handset
Delete
Opts
ON AIR
HOLD
PRETALK
Dialling...
Callin
Beendet
Line
Ringing Tone
Search
Names
New Entry
Edit
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View
Delete entry
Save as Quick Dial
Presets
Preset
Load
New
Save
Delete
Load Factory Settings
Ring Tone
Signal Processing
Keypad 9600, none
Status information
Login
Shift
G.711/Telephone
Auto Answer
Back
Default Audio Mode
Channel 1
Channel 2
AES/EBU Clock Source
Internal
External
Recovered
MSN 1
MSN 2
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S A F E T Y

Introduction

The unit described has been designed to the latest technical parameters and
complies with all current national and international safety requirements. It oper-
ates on a high level of reliability because of long-term experience in development
and constant and strict quality control in our company.

In normal operation the unit is safe.

However, some potential sources of danger for person, material and optimal op-
eration remain - especially if daily routine and technical errors coincide.

This manual therefore contains basic safety instructions that must be observed
during configuration and operation. It is essential that the user reads this manual
before the system is used and that a current version of the manual is always kept
close to the equipment.

General safety requirements

To keep the technically unavoidable residual risk to a minimum, it is absolutely
necessary to observe the following rules:

– Transport, storage and operation of the unit must be under the permissible 
conditions only. 

– Installation, configuration and disassembly must be carried out only by trained 
personnel on the basis of the respective manual.

– The unit must be operated by competent and authorised users only.

– The unit must be operated in good working order only.

– Any conversions or alterations to the unit or to parts of the unit (including soft-
ware) must be carried out by trained personnel authorised by the manufac-
turer. Any conversions or alterations carried out by other persons lead to a 
complete exemption of liability.

– Only specially qualified personnel is authorised to remove or override safety 
measures, and to carry out the maintenance of the system.

– External software is used at one’s one risk. Use of external software can affect 
the operation of the system.

– Use only tested and virus-free data carriers.
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Text Conventions

In this manual the following conventions are used as text markers:

Accentuation: Product names or important terms

LCD Text: Labelling on the front display of the system

PC Text: Labelling in the PC Software

TIP The symbol TIP marks information which facilitates the operation of the system in
its daily use.

NOTICE The symbol NOTICE marks general notes to observe.

ATTENTION The symbol ATTENTION marks very important advice that is absolutely to observe.
In case of non-observance disfunctions and even system errors are possible.

!



PAGE 15

C o n s t r u c t i o n

1 C O N S T R U C T I O N

The functions of the Connect Solo are implemented in a single unit. The system is
designed for mounting in a half 19" rack (1 U).

Optionally, a Connect Solo 19“ Dual Mounting Kit is available for the installation
of two Connect Solo Systems next to each other.

FIG. 1 FRONT VIEW OF CONNECT SOLO
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S y s t e m  D e s c r i p t i o n

2 S Y S T E M  D E S C R I P T I O N

The functional elements of the system are pictured in Fig. 2.

FIG. 2 FUNCTIONAL ELEMENTS OF CONNECT SOLO

2.1 Functionality

The Connect Solo System incorporates two independent analogue POTS inter-
face.

The complete signal processing is taken over by one digital signal processors. In
this way the following functions are realised:

DSP:

– Signal Processing

– Signalising Management

– Control of the complete system (Keypad, display, relays, TTL, RS232)

Via the main Audio channels the Audio signal is inserted or output analogue or dig-
itally. If the digital AES/EBU Audio interface is used, two separate Sample Rate
Converters are available for automatic clock synchronisation. For external clock-
ing a clock input and a clock output are available

The configuration and operation can be primarily carried out via the front keypad
and the illuminated display.

Configuration and control is especially comfortable with the Connect Solo Win-
dows PC Software which is included in delivery and which communicates with the
system via the RS232 interface.

The basic operating functions like accepting a call, dropping a connection and es-
tablishing a connection with a preprogrammed number can be carried out via
three programmable TTL contacts. Two relays are available for status indication.
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3 P U T T I N G  T H E  S Y S T E M  I N T O  O P E R A T I O N

3.1 Mounting

With its dimensions (W × H × D) of 220 mm × 44,5 mm (1 U) × 220 mm the Con-
nect Solo System can be used either as desktop device or mounted in 19 inch
racks. Corresponding 19“ mounting brackets are included in delivery. Optionally,
a mounting kit to install two Connect Solo next to each other is available.

When mounting the unit please keep in mind that the bending radius of the cables
is always greater than the minimum allowed value. 

When the Connect Solo Audio Codec is installed, please make sure that there is
sufficient ventilation: It is recommended to keep a spacing of ca. 3 cm from the
openings. In general, the ambient temperature of the system should be within the
range of +5°C and +45°C. These thresholds are especially to observe if the sys-
tem is inserted in a rack. The system works without ventilation.

During operation air humidity must range between 5% and 85%. 

3.2 Connection to the mains voltage

The system can be operated with mains voltages in the range from 90 V to 253 V
via the external power supply1 included in delivery. The line frequency can vary
from 45 Hz to 65 Hz. The maximum power consumption is 15W. The rack must be
earthed according to the VDE2 Regulations. The earthing can be carried out via
the earthing screw on the back side of the unit.

The unit does not have a circuit closer and a circuit breaker. After plugging in the
external power supply the system boots within a few seconds. In standby mode
the Connect Solo logo is shown on the display.

TIP The system temperature can be indicated on the display (Menu Status informa-
tion (see CHAPTER A1.4, Page 73))

ATTENTION Incorrect ambient temperature and humidity can cause functional deficiencies
Operation outside the threshold values indicated above leads to a loss of war-
ranty claim.

1 Depending on your country it can be necessary to change the power plug of the power supply. Country 
specific power plug adapter are included in the delivery.

2 The VDE is the German Association for Electrical, Electronic and Information Technologies, a profes-
sional body based in Frankfurt am Main. The role of the VDE in Germany is comparable to that of the 
IEE in the United Kingdom and the IEEE in the United States.

!
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3.3 Earthing of the system

For EMC1 reasons an earthing via the earthing screw of the system must be car-
ried out in either case.

3.4 Operational elements on the front side

The system has an illuminated graphical display with a resolution of 160 x 32 pix-
els and 19 operating buttons.

On the right next to the display there are two softkeys whose current functions are
indicated on the display. In the middle there are two buttons for navigation (selec-
tion upwards/downwards), two buttons for accepting/dropping calls as well as an

 button. The numerical pad supports in addition to the numerics 0...9 the ’*’
and ’#’ key. For text entries the numerical pad can also be used as normal keypad.

The operation is similar to standard mobile telephones.

FIG. 3 OPERATIONAL ELEMENTS ON THE FRONT SIDE

1 EMC = ElectroMagnetic Compatibility 

ATTENTION Earthing
A lacking earthing can cause functional deficiencies within the unit.

!

Softkeys Navigation
buttons

Establish connection
Accept call

Drop/
Main menu

Keypad for 
dialling/ text entry

2nd channel
shift

Confirm
entry/

Graphical
display

Status window
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3.5 Operating modes of the system

The figures below show the systems in a typical operation and their wirings.

The minimum wiring for the operation with an analogue telephone line is pictured
in Fig. 4.

FIG. 4 MINIMUM WIRING FOR SINGLE POTS OPERATION

The maximum wiring with all options is shown in Fig. 5. Via the RS232 control in-
terface a PC with Connect Solo Software can be connected as alternative to the
operation by the front keypad and display or the matrix.

FIG. 5 MAXIMUM WIRING FOR DUAL POTS OPERATION

NOTICE In the wiring diagrams the AES/EBU interface is used for normal operation with
the Digital Matrix equipped with CAT5 cards. The AES/EBU interface allows then
direct dial-out and accepting of incoming calls.
The available analogue Audio interface can also be used (AIO cards), but remote
control (dialling, accepting a call) is in this case not possible.

ATTENTION Earthing
In operation the system must be earthed via earthing screw for EMC reasons. If
the earthing is not carried out, the Audio signal can be faulty on the caller’s side
(humming).!

Power supply
interface

POTS
telephone
interface

AES/EBU Input

AES/EBU Output

Earthing!

Power supply

PC with 
Connect Solo

Software

interface

POTS 1
telephone interface

REL2

TTL1

TTL2

TTL3

Programmable
TTL Inputs/Outputs

REL1

Programmable
relays

AES/EBU Input

AES/EBU Output

POTS 2
telephone interface

TTL4

Standard analogue
telephones

Earthing!
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4 O P E R A T I O N  V I A  D I S P L A Y  A N D  K E Y P A D

In this chapter all basic configurations for the operation of the Connect Solo sys-
tem are explained. An overview of the menu structure you will find in the annex
under CHAPTER A1.

Of course, all configurations can also be comfortably made via the Connect Solo
Software included in delivery.

4.1 Basic configurations

In the following some specific basic configurations of Connect Solo are described
in detail.

4.1.1 Keypad lock

To avoid that keys are pressed accidentally you can enable a keypad lock. For ac-
tivation please press the Menu key followed by the * (star) button. If the keypad
lock is enabled the display illumination is turned off immediately.

The keypad lock is deactivated by entering the key sequence Menu * a second
time.

4.1.2 Setting the Audio interface: Analogue or digital

Connect Solo incorporates analogue as well as digital Audio interfaces which you
can adjust separately. The digital AES/EBU interfaces have integrated Sample
Rate Converters to adjust the digital Audio source to the transmission clock. Ad-
ditionally, clock inputs/outputs are also available. To configure the Audio inter-
face please follow the instructions below:

– First press the softkey  Menu and select System Settings via the softkey  
Select.

– With the use of the Select softkey you reach the option Audio.

NOTICE For the details of most functions please see the PC Software description from
CHAPTER 5.

NOTICE All menus can be reached directly via a QuickMenu key sequence. For this pur-
pose each menu item is marked with a cypher in the upper left corner (in the ex-
ample on the left it is e. g. 3). To reach a certain menu directly please enter from
the main menu the key sequence Menu <DIGIT> <DIGIT> whereby <digit> marks
the respective menu reference number. Please notice that the menu reference
number can change depending on the configuration.

NOTICE If you are not in the main menu please press the  button first.

Menu reference number
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– Please mark the option Audio interface in or Audio interface out using the 
cursor keys  and  and press again Select. Now the options Analogue 
(using with AIO cards) and Digital (using for CAT5 cards) are displayed. 

– Select the desired interface with the help of the cursor keys  and  and 
by pressing the softkey Select.

– Confirm your entry by pressing the Ok button or the softkey Ok.

– To get back to the main menu please press the  button. Now you are 
asked if you want to Save settings?. Via the softkey Yes the setting is stored 
permanently in the system.

TIP You reach the settings for the Audio interface in or Audio interface out via the
key sequence: Menu 1 1 1 or Menu 1 1 2
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4.2 Working with the Connect Solo

In the next chapters basic functions like establishing a connection, dropping a
connection, accepting calls etc. are described in detail. All these functions are
also possible via a Digital Matrix.

4.2.1 Calling a partner

From the main menu just enter the phone number using the keys 0...9. The input
field for the phone number is displayed automatically after entering the first cy-
pher.

With the softkey Delete misentries can be corrected.

The connection is established after the entry of the phone number by pressing the
telephone receiver button .

Under the softkey Opts (Options) the entered phone number can be saved in the
phone book (see CHAPTER 4.2.6, Page 27) or stored as Quick Dial number (see
CHAPTER 4.2.7, Page 27).

To enter a second calling number please press the Shift key (#) to select the de-
sired channel and enter the second calling number.

The connection is established after the entry of the calling numbers by pressing
the telephone receiver button .

4.2.2 The Status Display - Operation during a connection

After the telephone receiver button is pressed the partner is called and the status
window is displayed automatically.

The window is split if two independent connections have been established.

To switch between the two connections, please press the Shift key (#). The name
of the selected channel is displayed inversely.

An outgoing call is signalised by Dialling... . The dialled number (or the name if a
phone book entry is selected) is displayed in the first line.

When the connection is established the level indication for the incoming sig-
nal(Receive) and for the outgoing signal(Transmit) is displayed.

With the use of the softkey Opts the displayed phone number can be stored and
it is also possible to directly switch to the phone book.

NOTICE If you are not in the main menu please press the  button first.
From the main menu you reach the status window via the Ok button.

TIP The status window can always be reached by pressing the  button.
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4.2.3 Dropping a connection

The connection is dropped by pressing the telephone receiver button . If no
further connection exists, the main menu is displayed after a few seconds.

If the caller hangs up the system will recognise it after a few seconds.

4.2.4 Accepting a call

If the Connect Solo receives a call (automatic Ring Detection), it is automatically
signalised in the status window by Callin. The phone number will be shown auto-
matically on the display if the CLIP1 function is supported on the POTS line and if
the caller transmit the number (CLIR2). 

The call can be directly accepted with the telephone receiver button .

If you want to reject the call, please press the following telephone receiver button
.

For standard operation the option Auto Answer is set (Operation Settings Æ
POTS Æ Auto Answer). That means the system is answering the call without
further action.

NOTICE Please make sure that you have selected the right channel if you want to drop a
connection.

NOTICE Depending on the country it is possible that the Auto Disconnect doesn’t work.
Please inform in that case immediately our support.

1 Calling Line Identification Presentation

NOTICE Additionally, a system ringing tone can be enabled.

2 Calling Line Identification Restriction
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4.2.5 Comfort Functions

4.2.6 Redialling

You reach the redialling function by pressing again the telephone receiver button
 for the line on which no connection currently exists. The recently called part-

ners are displayed in a list. In the input field Search you can search for a certain
partner or select a partner from the list using the cursor keys  and  .

To call a partner please press again the telephone receiver button . 

4.2.7 Using the phone book

The system incorporates a comfortable phone book function. You reach the
phone book from the main menu via the softkey Names.

In the input field Search you can search for a certain partner. As soon as you enter
a character the corresponding phone book entries are filtered out.

Alternatively, you can select a partner from the list using the cursor keys  and
.

By the softkey Opts (Options) the following functions, which you can select via the
softkey Select, are realised:

– New Entry: With the help of this function you create a new phone book entry.
First enter the name and confirm your entry with Save.

Then enter the phone number of the partner. Confirm it as well with Save.

– Edit: This function allows you to edit already existing phone book entries.

– View: The selected phone book entry is displayed with name and phone 
number.

– Delete entry: The selected phone book entry is deleted. For safety reasons 
you are asked if you really want to delete the entry.

– Save as Quick Dial: Your 10 most important phone numbers can be pro-
grammed as Quick Dialling numbers on the numerical keys ’0’ ... ’9’. Please se-
lect the key from the list on which you want to programme the phone number.

NOTICE To enter characters you can use the alphanumeric keypad. You reach the desired
character by pressing the respective key several times. To type e.g. a ’K’ you need
to press the button ’5’ twice. Misentries can be corrected with the help of the
softkey Delete.
To switch between upper and lower case please press the SHIFT key. The display
changes from ABC to abc.

TIP It is also possible to store two different telephone numbers with different modes
in one phone book entry. After entering the first number please press the Ok but-
ton instead of the softkey Save. Now you can enter a second number and mode.
Confirm the entry with Save. If you select such an entry to be called both connec-
tions will be setup simultaneously.
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To activate a Quick Dialling number just press from the main menu the desired 
Quick Dial key for at least 3 seconds. The connection to the partner is estab-
lished automatically.

4.2.8 Working with Presets

The Connect Solo differentiates between System Settings and Operation Set-
tings.

System Settings are settings that do not change during normal operation like e.g.
audio interface, date/time etc. These parameters cannot be saved as Preset
since a configuration is usually only required when the system is put into opera-
tion.

Operation Settings like e.g. the Ring Tone, Signal Processing etc., need to be
reconfigured depending on the application. To easily recall recurring configura-
tions you can store up to 10 Presets in the system.

You reach the menu for the Presets by pressing the Menu softkey once, the cursor
key  twice and by pressing the softkey Select once as confirmation.

In the input field Presets you can search for a certain Preset. As soon as you enter
a character, the corresponding entries of the Preset list are filtered out.

Alternatively, you can select a Preset from the list using the cursor keys  and
.

If you now press the Ok button, the selected preset is loaded immediately.

By the softkey Opts (Options) the following functions which you can select via the
softkey Select are realised:

– Load: The stored Preset is loaded.

– New: With the help of this function you can create a new Preset. All current Op-
eration Settings are stored.

– Save: The currently selected Preset is overwritten with the current Operation 
Settings. For safety reasons a confirmation is required.

– Delete: The currently selected Preset is deleted. For safety reasons a confir-
mation is required.

– Load Factory Settings: The system is loaded with the factory settings.

TIP The phone book functions can also be reached directly via the QuickBook func-
tion. Please press the following key sequence: Names Opts <DIGIT>
Example: Save as Quick Dial - Names Opts 5

NOTICE If the configuration has changed, you are asked if you want to Save settings?
when you leave the Preset menu. Via the Yes softkey the configuration is stored
permanently in the system. This Preset is loaded automatically by the system af-
ter the unit is connected to the power supply.
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4.3 Settings for operation with an Artist System

POTS settings and Audio Mode/Auto Answer

– Press the softkey MENU and use the cursor keys  and  to select Opera-
tion Settings. Confirm it with Select.

– Select POTS and then Auto Answer, enable it with Select. Confirm with .

Press Back to get back to Operation Settings.

Depending on the hardware configuration of your Artist System you must config-
ure the Audio Input and output in the right way:

• Artist System with CAT5 card: Digital AES/EBU Audio interface

– Use the cursor keys to select System Settings. Confirm with Select.

– Select Audio and set Audio interface in and Audio interface out to
Digital by pressing Select and confirm it with .

– Remain in Audio SETTINGS and set the AES/EBU Clock Source to
Recovered, press Select and confirm it with . 

• Artist System with AIO card: Analogue Audio interface

– Press the softkey MENU and use the cursor keys  and  to select Sy-
stem Settings. Confirm it with Select.

– Select Audio and set Audio interface in and Audio interface out to
Analogue by pressing Select and confirm it with .

Press button  to get back to the main menu. You will now be asked whether
you want to save the settings. Press the Yes softkey to store the new settings per-
manently.

NOTICE Analogue connection to the Artist requires additional GPIO to TTL/Relay cable in
order to dial from the intercom system. Using the analogue connection in conjunc-
tion with a GPI cable allows dialing from the Artist. In this case the telephone
number has to be stored in the codec previously (see CHAPTER 5.5.2.2.3).
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5 W I N D O W S  P C  S O F T W A R E

The configuration of the system is particularly comfortable via the Windows PC
Software included in delivery.

5.1 Hardware requirements

The PC must meet the following minimum requirements:

– IBM PC AT, IBM PS/2 or 100% compatible

– Pentium Processor (> 500 MHz) recommended

– Windows 2000/XP

– ca. 600 kByte available RAM

– 5 MB available hard disk space

– Screen resolution with 800 x 600 Pixels

– at least one available serial interface RS-232

– Microsoft, IBM PS/2 or 100% software compatible mouse

5.2 Installing the Windows PC Software

Please insert the CD included in delivery in your CD-ROM drive. You will find the
installation file setup.exe on the CD.

Please follow the instructions of the installation routine.

After the installation the software can be started by clicking on the Connect Solo
icon.

Please connect your PC via a serial 1:1 cable (only Pin 2 and Pin 3 are used, Pin
5=ground) with the system.

The standard COM Port settings are: PC (38400 Baud)

Operation via Windows PC software

In the following chapters all functions of the PC software are described in detail.
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5.3 The Connect Solo main window

After starting the Connect Solo Software, the main window is displayed automat-
ically (see Fig. 6). 

The connection status between PC and system is displayed in the top right corner
of the window:

PC ONLINE: Connection is okay.

NO CONNECTION: Connection with PC is faulty

Following further status messages are possible:

PC ONLINE ALARM: Upcoming alarm (see System Monitor, green-dark green
blinking)

FIG. 6 MAIN WINDOW OF THE CONNECT SOLO SOFTWARE

5.3.1 Operating elements

5.3.1.1 Info button

On the INFO button the information about the caller is shown. If transmitted the
phone number of the caller is displayed. If additionally a phone book entry is avail-
able, the caller’s name is displayed.

NOTICE If the connection is faulty, please check the following points:
– External power supply of the system is plugged in (display available)
– Serial 1:1 cable is connected with PC and system
– Correct COM port and correct baud rate are selected in the software (Config-

uration → COM Port, see Page 59)

Status of the
PC connection

Caller Information
(Name, Phone Number)

Menu bar

Drop Line

Transmitting level

Received level

Phone number display

Phone book
Redialling

(Last 10 phone numbers)

Connection Status:
Send

Receive

Calling/
Accept Call

Second ChannelFirst Channel
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During Call In or Call Out the INFO button will be displayed in yellow, during a con-
nection the INFO button is red.

By pressing the INFO key the phone book ((see CHAPTER 5.3.1.4) is opened
and the entry can be edited immediately.

The button CALL initiates a call in the selected transmission mode to the phone
number which is displayed in the phone number display.

If there is an incoming call a blinking ACCEPT button is displayed instead of the
CALL button.

If the connection is established a green CONNECT button is shown.

Via the DROP key the connection to the caller can be dropped.

When there is an incoming call, all keys are displayed in yellow and blinking. Re-
spectively, each of these keys can be selected.

In contrast to this, when there is an outgoing call, the key CALL will be labelled
with CALLING whereas the key DROP is displayed yellow and blinking. Only the
DROP button can be selected.

5.3.1.2 Level indicators

The outgoing transmitting level as well as the received level of the caller are dis-
played via separate level meters.

5.3.1.3 Redialling

Via the Redialling button the ten last dialled telephone numbers are available.
The redialling list is indicated with transmission mode as well as the phone
number.

After selection an entry the outgoing call will be immediately initiated.

5.3.1.4 Phone book

With the use of the Phone Book key telephone numbers can be saved comfort-
ably in the phone book. 

To open the phone book, please press the phone book button (see Fig. 7).

In the Search field you can search directly for a name in the phone book. As soon
as a match is found the corresponding record is displayed with Name and
Number.

NOTICE The phone book is stored in the Connect Solo system and not in the PC. Via the
menu File → Phone Book → Import/Export a phone book can be imported
from a data file or exported as data file (see CHAPTER 5.4.1).
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FIG. 7 PHONE BOOK

To create a new entry, please press the button NEW whereby an empty phone
book entry is displayed. There you can enter the name and the phone number.

FIG. 8 EDIT NEW PHONE BOOK ENTRY

By the use of the EDIT button an already existing record can be edited. The
search function is not available here.

Via the button DELETE the currently displayed record is deleted.To avoid unin-
tentional deleting, you have to confirm that you really want to delete the entry with
Yes.

By using the Close button the phone book will be closed.

Via the CALL button a direct call to the displayed phone book entry is possible.

5.3.2 Status elements

The Connection Status will be displayed for each channel and separated for
Encoder and Decoder in the connection status field.

The following information is available:

TIP It is also possible to store two different telephone numbers in one phone book en-
try. If you select such an entry to be called both connections will be setup simul-
taneously.

ATTENTION The name entered in the phone book has to be unique. Identical names are not
permitted.The best way to provide a clear identification is to enter the last name
and the first name.
If the name already exists, an error message is displayed.

Search

Name

Phone Number

New
entry

Edit
entry

Delete
entry

Close
Phone Book

Call to
selected entry

!
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– Signalling: Transmission mode Telephone for the connection.

– Mode: 3.1 kHz or off
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5.4 Menu File

FIG. 9 MENU FILE

5.4.1 Phone Book

Via the submenu Phone Book a complete phone book can be imported or ex-
ported from a data carrier (e.g. disk, USB stick) to the system or from the system
to a data carrier.

Select the desired function Import or Export.

Used formats:

– The phone book is saved as CSV file. This format can be opened with any text 
editor or edited with MS EXCEL.

Example:

Connect Solo;3;2
Name;Call  Mode 1;Cal l  Mode 2;Number 1;Number 2
MEYER;1;1;02024567890;02024567891
MILLER;1;0;130;

Please note: The first two lines form the header and must not be missing.
Call modes syntax:

– 0 = not used

– 1 = Telephone

– 2 = Reserved

5.4.2 Basic Settings

To Import/Export the basic settings of a system please use the submenu Basic
Settings. The file format is binary and cannot be edited (see CHAPTER 5.4.2).

5.4.3 Submenu Exit

Via the submenu Exit you exit the Connect Solo software.
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5.5 Menu Configuration

FIG. 10 MENU CONFIGURATION
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5.5.1 Submenu COM Port

The system is connected via the serial RS232 interface with a 1:1 connecting ca-
ble to a PC. The configuration of the COM Port of the PC can be carried out under
Configuration → COM Port.

FIG. 11 RS232 PARAMETER OF THE COM PORT

As Port you select the interface of your PC which is connected to the Connect
Solo.

Under Mode you can set the desired operating mode:

– PC (9600 Baud)

– PC (19200 Baud)

– PC (38400 Baud): Default setting

– PC (57600 Baud)

– PC (115200 Baud)

All further parameters like Data Bits, Parity and Stop Bits cannot be config-
ured.
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5.5.2 Submenu Connect Solo

Via the submenu Connect Solo the system can be configured comfortably. It is
distinguished between Basic Settings, which do not have to be changed during
the operation and the actual Configuration for the current application. In con-
trast to a configuration, the basic settings cannot be saved as Preset (see CHAP-
TER 5.5.3).

5.5.2.1 Configuration

All settings made under Configuration can be saved as Preset.

5.5.2.1.1 Line Interface

Via the option Line Interface the POTS telephone interface can be configured.

FIG. 12 LINE INTERFACE

General

• Via the function Enable Auto Answer the auto answer can be activated. Us-
ing the Delay slider a period in a range from 0 ... 31 seconds can be config-
ured after the system should answer a call.

• It is possible to activate a ring tone as audible signal for incoming calls via the 
function Enable System Ringing Tone. This function is only enabled if En-
able Auto Answer is not activated.

• If the POTS 50 Hz Filter is activated, a disturbing 50 Hz humming is filtered 
out. The spurious signal is injected via the POTS connection in the system.The 
reason is in the majority of cases an incorrect cabling of the private branch ex-
tension.
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• The option Redial Delay after Disconnect avoids permanent re-dialling (e.g. 
via a TTL pin) without a pause. After a disconnect you must normally wait a few 
seconds before you can re-dial. The delay can be configured in a range from 
0...7 seconds.

Prefix number 

• Under Length of internal telephone numbers the length of your internal 
telephone numbers is set. Subsequently, the prefix number is automatically di-
alled first if the length of the telephone number exceeds the length specified 
in this setting.
If you do not want to use this function or if you operate the system with a main 
telephone station, enter 0.

Examples: 

Length of internal telephone numbers: 3
Entered telephone number: 130
Dialling: 130

Length of internal telephone numbers: 3
Entered telephone number: 292130
Dialling: 0 292130

• Under External prefix number please enter the prefix number that you need 
to get an external line. In most cases it is 0.

• Some private branch exchanges transmit telephone numbers with prefix 
number to the system. If you enable the function Skip prefix number on in-
coming call, you can save a displayed number in the phone book without pre-
fix number since the prefix number of the displayed number is deleted auto-
matically.

NOTICE The following configurations are only necessary if the system is operated with a
private branch exchange.

ATTENTION You need to enter the prefix number at any rate if you work with a private branch
exchange because otherwise the system does not wait for the free-line signal.
Without dialling the prefix number at a private branch extension the telephone
number is transmitted too fast and no connection can be established.!
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5.5.2.1.2 Signal Processing

With the option Signal Processing configurations to optimise the caller signals
can be carried out. It is possible to configure the AGC (Automatic Gain Control),
the Echo Canceller as well as the Expander.

FIG. 13 SIGNAL PROCESSING

Line Settings

• A separate Automatic Gain Control (AGC) can be switched on for both chan-
nels.

Please select the desired line with your mouse and press the button Edit, 
which opens the configuration window. To switch off the AGC select Off. To 
switch it on select On.

FIG. 14 CONFIGURATION AGC AND ECHO CANCELLER

Via the button Set AGC on/off for all lines you can switch on respectively 
switch off the AGC for all lines.

ATTENTION An Automatic Gain Control is reasonable if you do not have the possibility to adjust
the level manually.

But: An AGC is no wizard. Extremely low callers cannot be boosted boundlessly.
Extremely loud callers cannot be toned down boundlessly.

!
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• An Echo Canceller can be set on or set off separately for each channel.

Select the desired line with your mouse and press the button Edit, which 
opens the configuration window (see Fig. 14). To generally set the Echo Can-
celler off select Off.

If you always want to have the Echo Canceller activated select Always ON. 
In this case, no test tone to detect the echo is sent.

If the option Auto is selected, the Echo Canceller is switched on or switched 
off dynamically. The system sends a short test tone to determine if an Echo 
Cancelling is required or not.

Via the button Set EC on/off/auto for all lines you can select the same op-
erating mode of the Echo Canceller for all lines.

Automatic Gain Control Settings (AGC)/Expander

The correct functioning of the AGC can be optimised via several parameters.

• Threshold : The AGC does not start before the signal exceeds the threshold 
value set here. The default setting is -30 dBu.

• Level :The level set here corresponds with the average desired level. Please 
consider sufficient head room. The default setting is -12 dBu.

• Speed : Depending on the desired speed of the level adjustment (Slow or 
Fast) the setting of the AGC speed can be configured here. The faster the AGC 
must work the more noticeable are the inconsistencies. If the set speed is too 
slow, the caller signal is too low or too loud on average. The default setting is 
Medium.

• An Expander tones down the caller signal automatically, if its level falls below 
a certain threshold value. The aim is to completely filter out background noises 
of callers who are not currently speaking.The Expander is activated by check-
ing the respective box.

• With the use of the key Default Settings the default settings named above 
can be configured and the Expander can be activated.

NOTICE In general, the use of the Echo Canceller is recommended. When a subscriber
calls on the system with an analogue telephone, a line echo is produced which
can interfere with the incoming signal. Digital telephones (e.g. ISDN or mobile
phones) do not produce these line echoes. In this case an Echo Canceller would
worsen the incoming signal. For this reason the system sends a short test tone
when a connection is established (only in the Auto mode) and detects the level
of the echo. If a certain threshold value is not exceeded, the Echo Canceller is set
off because the use of a digital phone on the counterpart is anticipated. If the
level is too high, the Echo Canceller is set on automatically.

But: Echo Cancellers can only suppress echoes if the delay of the signal lies
within a certain scope. Telephone connections via satellite have such a long delay
that the Echo Canceller cannot work properly anymore.



PAGE 43

W i n d o w s  P C  S o f t w a r e

5.5.2.2 Basic Settings

5.5.2.2.1 General

FIG. 15 GENERAL

Key Tone

• To activate the Key Tone of the front keypad, check the Enabled box.

Display

• The Display has a backlight. Under the setting Backlight you can switch it 
ON permanently. If you select the option Auto the backlight is turned off au-
tomatically 60 seconds after the last keystroke. The backlight is activated 
again by pressing any key (e.g. Ok).

• Via the slide control Contrast you can adjust the contrast in the range -16 ... 
15 for the display. The default setting is 0.

RS232 Interface

• If you want to operate the system with the PC, you must set the data rate in 
accordance with the interface. There are five baud rates available: PC (9600 
Baud), PC (19200 Baud), PC (38400 Baud), PC (57600 Baud) and PC 
(115200 Baud).

NOTICE All configurations made under Basic Settings cannot be saved as Preset (see
CHAPTER 5.5.3).

NOTICE Please notice that if the keypad lock is activated, the backlight is only switched
on again by pressing the key sequence Menu * .
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Phone Interface

• If you have connect a normal telephone to one of the two available phone in-
terfaces you can use it for e.g. dialling. In this case select Enabled for Line 
1/2 otherwise Disabled.
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5.5.2.2.2 Audio Interface

Connect Solo supports analogue as well as digital AES/EBU Audio interfaces. If
the digital interfaces are used, a separate Sample Rate Converter is available for
the input and the output so that external adjustments are not required if there are
different digital sources and drains.

FIG. 16 AUDIO INTERFACE

Audio Interface

• The operating mode analogue or digital can be set separately for the Audio 
Input and the Audio Output.

• If the output is set digital, additionally the configuration for the AES/EBU In-
terface is displayed. Under Clock Source of digital output you can select 
the following options:

– Internal: The AES/EBU output clock is derived from the internal system
clock.

– External: The AES/EBU output clock is derived by the external clock con-
nected via the interface Audio 2/CLK IN. The clock rate of the connected
clock must be 48-kHz.

NOTICE The digital AES/EBU Audio interface should be used as standard Audio interface.
Otherwise a remote control from a Digital Matrix is not possible (dialling, accept-
ing a call etc.).
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– Recovered: The AES/EBU output clock is derived from the digital input sig-
nal of the interface Audio 1/AES IN. This configuration is usually to be se-
lected if you use the digital input of the system. In this way a synchronous
functioning of the transmission chain is ensured  

• If you operate the input or the output in an analogue mode, the corresponding 
slide control for adjusting the nominal Audio level of the Audio interface (Main 
Nominal Level) is displayed. The nominal level can be adjusted separately for 
the input (Level In) and for the output (Level Out) in the range of -3 ... +9 
dBu in 1-dB steps. The head room is 6 dB in general. If you want to have the 
maximum level of 15 dBu for the system, you must set 9 dBu as nominal level. 
The default settings are 0 dBu.

NOTICE The AES/EBU input always works with recovered clock, therefore a configuration
of the output is required.
For clock synchronisation to other systems you can use the Audio Output Audio
2/CLK OUT. The clock rate of the output clock is 48-kHz.
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5.5.2.2.3 Relay / TTL 

The Connect Solo system incorporates four GPIO Pins (TTL) which can be pro-
grammed separately as input or output. Additionally, two Relays are available.

The operating mode of a TTL-Pin - Input or Output is selected via the option Di-
rection.

The following specification accounts for all three configuration windows TTL1,
TTL2, TTL3 and TTL4.

TTL-Pin as input

FIG. 17 TTL-PIN AS INPUT

If you use a TTL-Pin as Input, you can program two different functions separately
when edges change:

• Positive edge: The event is activated when the voltage on the TTL-Pin 
changes from 0V to +5V.

• Negative edge: The event is activated when the voltage on the TTL-Pin 
changes from +5V to 0V.

The following functions can be configured (Function Code):

– -: No function, the negative edge is not used.

– Call Number:
Via this function you can establish a connection to a certain Number. with
desired Transmission Mode. Under Line you select the line (1 or 2) on
which the connection is established. If you select 1 it is possible to setup
two independent connections with different numbers.
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– Call Number (level triggered):
Same function as Call Number, but the event is activated level triggered
and not edge triggered.

– Disconnect: If you activate this function, a connection on the selected
Line (1 or 2) can be disconnected.

– Load Preset: Via this function it is possible to load a preset which you
have to select under Preset.

– Set Information Base entry: Reserved for future applications.

– String Command: Reserved for future applications.

Example:

You want to initiate a call on line 1 with TTL 1. After the transmission has 
been finished the connection is to be cleared with TTL 1.

Programming:

Positive egde:

Function Code: Call Number
Line: 1
Transmission Mode: G.711/Telephone
Number: 0202292130

Negative egde:

Function Code: Disconnect
Line: 1

FIG. 18 SEQUENCE OF EVENTS FOR THE EXAMPLE

1 5

6 9

use 9-pol. SUB-D connector
to Connect Solo

(TTL/RELAY)

Switch is opened:
Pin 1= TTL 1 is on +5 V (via internal 10 KOhm series resistance)

Switch is closed:
Pin 1=TTL 1 is set to 0V (Pin 5):
Existing connection is disconnected

Switch is opened:
Pin 1=TTL 1 is set to +5V:
Outgoing call is accepted.

Switch
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TTL-Pin as Output

FIG. 19 TTL-PIN AS OUTPUT

If a TTL-Pin is configured as Output, the event is signalised as change of voltage
on the TTL-Pin from 0V to+5V.

Under Positive edge you can select one of the following Function Codes:

– Fixed to Low (0V): The TTL-Pin is set to 0V permanently.

– Fixed to High (5V): The TTL-Pin is set to +5V permanently.

– PC Controlled: Reserved for future applications.

– Connection State: Via Connection State you can signalise the connection 
state of a line. The following configurations are possible:

– Disconnect 

– Call Out

– Call In 

– Connect

– Call Setup

ATTENTION Please pay attention to the maximum switch current of 10 mA respectively the
maximum switch voltage of 5V per TTL output.

!
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Under Line you select the line whose status you want to signalise. In addition 
to line 1 and line 2 you can monitor the connection status of both lines if you 
select the option all. As soon as one of the two lines meets the criteria, the sig-
nal is set on the TTL-Pin.

– Information Base entry: Reserved for future applications.

– System Alarm Pending: If one of the possible system errors (see CHAPTER 
5.7.1) occurs, it can be signalised by selecting this option.
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Relay

The following description applies for both configuration windows Relay 1 and Re-
lay 2.

FIG. 20 RELAY 

The options for the relay configuration are identical with the configuration of a TTL-
Pin. The following Function Codes are available:

– Always open : The relay contacts are always open.

– Always closed : The relay contacts are always closed.

– Connection State : With the use of Connection State you can signalise the 
connection state of a line. The following configurations are possible:

– Disconnect 

– Call Out

– Call In 

– Connect

– Call Setup

Under Line you select the line whose status you want to signalise. In addition 
to line 1 and line 2 you can monitor the connection status of both lines if you 
select the option all. As soon as one of the two lines meets the criteria, the sig-
nal is set on the TTL-Pin.

– Information Base entry: Reserved for future applications.

ATTENTION Please pay attention to the maximum switch current of 200 mA respectively the
maximum switch voltage of 48V per relay output.

!
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– System Alarm Pending: If one of the possible system errors (see CHAPTER 
5.7.1) occurs, it can be signalised by selecting this option.
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5.5.2.2.4 Quick Dial

Up to 10 Quick Dial keys 0... 9 can be programmed in the system. The Quick Dial
keys are displayed in the right part of the main window.

FIG. 21 QUICK DIAL

Select <unused> if the Quick Dial is not used.

If you want to program a number, select the option Number and the phone
number in the right fields. A possibly required prefix number must not be added if
you have already configured it (see Page 40, Prefix number).

Alternatively, you can select an entry directly from the phone book. Select the op-
tion Phone book. In the right field the list of all available phone book entries is
displayed.
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5.5.2.3 Login

To protect the system from re-configurations, two password levels with different
user rights are available. 

• Under USER you assign the user Password. For safety reasons you must 
confirm the password under Confirm Password.

• Under ADMINISTRATOR you assign the Administrator Password. For safety 
reasons you must confirm the password under Confirm Password.

FIG. 22 LOGIN

When you have assigned a password, the window for the password entry is auto-
matically displayed when you click on a menu with password protection. Please
enter the User Password or the Administrator Password.

FIG. 23 PASSWORD LOGIN

The authorisation levels are defined as follows:

ATTENTION The entered password is saved in the system. It is highly important that you enter
your password carefully. If you have forgotten your password, only the Riedel Serv-
ice can re-activate the system.

NOTICE There is no differentiation between upper and lower case for the password entry.

!
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(1) Only Administrator Password is configured: The password must be entered 
for configuration changes. Immediately available menus:

– File → Phone Book → Export

– File → Basic Settings → Export

– Configuration → Presets → „Configuration Name“

– Administration → Registration

– Extras → System Monitor

– Help → About Connect Solo

(2) Only User Password is configured: The password must be entered always.
Afterwards all menus are available. Immediately available menus:

– Help → About Connect Solo

(3) User Password and Administrator Password are configured: The password
must always be entered.

User Password is entered:

Under Configuration → Configuration → Login the USER pass-
word can now be changed.

Via Configuration → Presets the desired configuration can be 
loaded.

Immediately available menus: 

– Extras → System Monitor

Administrator Password is entered: All menus are available.

NOTICE Please pay attention to the configuration options of the system if a password is
assigned (see CHAPTER A1).
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5.5.2.3.1 Date and Time

Via the panel Date and Time it is possible set the internal clock of the system.

To synchronise the System Time to the PC Time press the button Transmit PC
Time.

To setup another time e.g. for other time zones you can enter a User Defined
Time. To set the time in the system press the button Transmit User Defined
Time.

FIG. 24 DATE AND TIME
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5.5.3 Submenu Presets

Via Presets you can load already created configurations.

5.5.3.1 Manage Presets

Your created Presets can be managed via the menu Configuration → Presets
→ Manage Presets.

FIG. 25 MANAGE PRESETS

All already existing configurations are displayed in the list.

• With the use of the New button you create a new configuration. The current 
configuration of the system is not changed or loaded by this function. First, se-
lect an expedient name. The length of the name must not surpass 8 charac-
ters. Special characters and space characters are not allowed. Please mind 
that you use unique names.

Subsequently, the configuration dialogue is opened for the editing of the Pre-
sets. The current configuration is always displayed as basis of a Preset which 
you can adjust according to your wishes. The following configurations can be 
saved as Preset:

– Line Interface (see Page 39)

– Signal Processing (see Page 41)

• By using the button Edit the currently selected configuration can be edited. 
The current configuration of the system is not changed or loaded with this 
function.

• Via the button Delete the configuration selected from the list is deleted. For 
safety reasons you have to confirm your selection.

• To activate a configuration selected from the list, press the Select button. For 
safety reasons you have to confirm your selection.

• Via the button Import a configuration can be imported from a data carrier 
(disk, USB stick etc.). The file extension of the configuration file is always ‘.pst‘. 
A click on the button opens the file browser in which the desired file can be se-
lected.
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• Likewise, it is possible to export configurations to a data carrier. The button 
Export saves the configuration selected from the list as ‘.pst‘ file. By clicking 
on the button the file browser is opened and you can choose the location 
where the file is saved.

With Export All all configurations displayed in the list are saved in a directory 
of your choice. A separate data file with the file extension ’.pst‘ is generated 
for each configuration.

5.5.3.2 Activation of a Preset

All Presets are displayed under Configuration → Presets → „Preset Name“
and can be activated with a click.

FIG. 26 ACTIVATION OF A PRESET

For safety reasons a confirmation is required.

TIP If you need to configure several systems in the same way, set up one system first
and export all configurations to a disk. To configure all further systems easily, im-
port the configurations from the disk.

This is also possible for the Phone Book and Basic Settings. Via the Im-
port/Export function under File (see CHAPTER 5.4) you can comfortably save all
information and load on other systems.
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5.6 Menu Administration

FIG. 27 MENU ADMINISTRATION

5.6.1 Submenu Registration

The data concerning production as well as the enabled options can be displayed
under the submenu Registration.

FIG. 28 SUBMENU REGISTRATION

The data of the unit include the following information:

– Hardware

– Subject Number

– Factory Number

– Year of production

– Hardware Version

• Under Features the available and activated Software Options of the Con-
nect Solo are displayed. Deactivated options can be activated via a password. 
This password is assigned according to the Factory Number. If you bought an 
option supplementarily, please enter the password that you received from us 
under Enter Password.

This number
is required
to enable

software options
supplementarily
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FIG. 29 PASSWORD ENTRY TO ENABLE AN OPTION

Subsequently, the system executes a warm start. Afterwards, the functions are ac-
tivated.

ATTENTION Please enter the password carefully.

If you enter a wrong password three times, you must switch off the system and
switch it on again.!
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5.6.2 Submenu File System

Selecting the submenu File System the storage system (similar to a PC’s hard
drive) of the system is displayed.

FIG. 30 SUBMENU FILE SYSTEM

• The button Delete File deletes the currently selected file from the system.

• Via the button Copy PC -> Unit you can copy a file from the PC to the system.

• Via the button Copy Unit -> PC you can copy a file from the system to the PC.

ATTENTION Please do not use the File System unless our Service requested a specific action.

ATTENTION Please do not delete any file unless our Service requested a specific action. Oth-
erwise a disfunction of the system is possible.

ATTENTION Please use the Software Download and the File Import functionalities respec-
tively to copy files to the system.

ATTENTION Please use the File Export functionalities to copy files to the PC.

!

!

!

!
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5.6.3 Submenu System Panel

The System Panel is only for service purposes. Please enter only commands in
the prompt, if our Support requested it from you.

FIG. 31 SUBMENU SYSTEM PANEL
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5.6.4 Submenu Software Download

The required firmware for the Connect Solo system is always included in the PC
software: Via the Software Download you can comfortably download the
firmware on your system.

By using the Browse button you select the firmware file. It is always located in the
same directory in which you installed the Connect Solo application. The standard
installation directory is:

C:\Program Files\Connect Solo

The file name of the firmware is „solo.ssw“.

FIG. 32 SUBMENU SOFTWARE DOWNLOAD

Please press the Start button to download the firmware. The Progress bar dis-
plays the progress of the download. The process is finished after about two min-
utes. If the download was successful, a corresponding message is displayed. After
your confirmation the system is reset.

NOTICE If the download was not successful, you can simply switch off the unit and switch
it on again. The new software is only written in the flash memory if the download
was successful. Otherwise the old firmware is maintained.
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5.6.5 Submenu Set Factory Settings

By using the submenu Set Factory Settings the system can be reset to the ini-
tial state.

For safety reasons you have to confirm your selection.
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5.7 Menu Extras

FIG. 33 MENU EXTRAS

5.7.1 Submenu System Monitor

Via the menu System Monitor you receive information about the system status.

FIG. 34 SUBMENU SYSTEM MONITOR

• Under System alarms all potential alarms are displayed. A red LED signalises 
a currently existing alarm. How often the error occurred since switching on is 
displayed by the corresponding alarm counter. To reset the alarm counter 
press the button Alarm Counter Reset.

The following errors are signalised:

– LCA: The communication with a programmable component is faulty.

– TIME KEEPER: The communication with the integrated clock module is
faulty.

– A/D D/A CONVERTER 1: The communication with the first ADDA con-
verter is faulty.

– A/D D/A CONVERTER 2: The communication with the second ADDA con-
verter is faulty.

– TEMPERATURE SENSOR: The communication with the temperature
sensor is faulty.

– FLASH EPROM: The communication with the permanent memory is
faulty. Configurations cannot be saved or read anymore.

– MAIN EEPROM: The communication with the permanent memory is
faulty. Configurations cannot be saved or read anymore.

– OVERHEATED: The system sets this alarm if the system temperature is
higher than 57°C. Disconnect the unit from electricity or cool down the am-
bient temperature.

NOTICE If an alarm occurs frequently or over a longer period disconnect the unit from
electricity. If the error occurs again after switching on, there is probably a hard-
ware defect.

Alarm Counter
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– AES3 Framing: This status LED informs about the AES/EBU input signal. 

The actual system temperature is displayed in °C under System Tempera-
ture. The regular system temperature ranges from 30...40°C.

Under DSP Load the load of the system is displayed. The usual load is about 
55 to 65%.

TIP A system alarm can also be configured as relay output (see Page 47).
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5.8 Menu Help

FIG. 35 MENU HELP

5.8.1 Submenu About Connect Solo

In the About Connect Solo dialogue you find the software versions of the PC
software (PC Version) and of the systems (Firmware Version). Besides, you
can find our contact details there.

FIG. 36 SUBMENU ABOUT CONNECT SOLO
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A 1 M E N U  S T R U C T U R E

On the following pages you will find the complete menu structure.

From the main menu you reach the phone book directly via the softkey Names.
With the use of the softkey Menu you get to the configuration of the system.

The configuration menu is divided in five submenus:

– System Settings

– Operation Settings

– Presets

– Status information

– Login

If you use an Administrator and/or User Password, the display looks as it is de-
scribed below:

(1) Only Administrator Password configured: The password must be entered 
for changes to the basic settings and operation settings only. Immediately 
available menus:

– Presets

– Status information

– Login

(2) Only User Password configured (instead of Menu, Login is displayed): The
password must always be entered. Subsequently, all menus are available.

(3) User and Administrator Password configured (instead of Menu Login is dis-
played):

– User Password is entered: The menus Presets, Status information 
and Login are available

– Administrator Password is entered: All menus are available.

NOTICE Please note that depending on the selected operating mode some menu items
are not displayed.

NOTICE There is no differentiation between upper and lower case for the password entry.
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A1.1 System Settings

Presets

Status Information

Operation Settings

Login
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A1.2 Operation Settings

Presets

Status Information

Login
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A1.3 Presets

Status Information

Login
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A1.4 Status Information

Login
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A1.5 Login
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A1.6 Names
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A 2 T R O U B L E  S H O O T I N G

TAB. 1 TROUBLE SHOOTING

Problem Possible cause

On the analogue telephone line no 
external connection can be estab-
lished.

If you operate the system with a private branch exchange, a prefix 
number must be entered (see CHAPTER 5.5.2.1.1).

A radio signal is received. Please check if the POTS line is twisted. The system must be 
earthed via the earthing screw (see Page 21).

There is a humming audible. Please enable the 50 Hz filter. The humming is injected via the 
POTS connection (see CHAPTER 5.5.2.1.1).

The Echo Canceller is not working. If you switch callers via a Call-In Center to the system the Echo 
Canceller is possibly adjusted incorrectly. Enable the Echo Cancel-
ler permanently (see CHAPTER 5.5.2.1.2). Please notice that ech-
oes of more than 32 ms cannot be filtered out anymore.

You are working with a Terminal Adapter. Often such a system has 
no attenuation and the send signal is reflected approximately one-
to-one. In this case the system cannot decide if the signal is from 
the other side or a local echo. To avoid such problems use only 
standard POTS interfaces from Telecom operators.

Auto Disconnect doesn’t work. Depending on your country this function is not supported. Please 
inform our support.

The re-dial functionality using a TTL 
pin works not properly.

Increase the re-dial delay after disconnect (see 
CHAPTER 5.5.2.1.1)
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A 3 I N T E R F A C E S

The interfaces of the system are pictured in Fig. 37.

FIG. 37 REAR VIEW OF THE CONNECT SOLO SYSTEM

All interfaces are described below.



PAGE 80 

I n t e r f a c e s

A3.1 Analogue telephone interfaces

A3.1.1 POTS1 1 & 2 interface

Via these interfaces the system can be connected to two independent analogue
telephone lines. A connecting cable for phone jacks is included in delivery. 

A3.1.2 PHONE 1 & 2 interface

Via these interfaces a standard analogue telephone for operation can be con-
nected. 

1 POTS = Plain Old Telephone Service

TAB. 2 PIN ASSIGNMENT: ANALOGUE POTS TELEPHONE INTERFACE (LINE POTS)

Socket: Western (6-pole) RJ12

Pin Signal Electrical characteristics

1 not used Typical characteristics:

Bandwidth: 300 - 3.3 kHz
Signal to noise ratio:  45 dB
Average level:  -9 dBm (275 mV)
Impedance:  600 ohms
DC voltage:  48 V (±6 V typ)
DC current:  20-26 mA (typ)
Ringing voltage:  90 Vrms
Ringing frequency:  20 Hz (2 sec. on, 4 sec. off)

2 not used

3 TEL LINE a

4 TEL LINE b

5 not used

6 not used

TAB. 3 PIN ASSIGNMENT: ANALOGUE PHONE INTERFACE (LINE PHONE)

Socket: Western (6-pole) RJ12

Pin Signal Electrical characteristics

1 not used

2 not used

3 TEL LINE a

4 TEL LINE b

5 not used

6 not used

1 6

1 6
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A3.2 Control interface

A3.2.1 CTRL interface

The CTRL interface is used for the configuration and operation of the Connect
Solo system via a PC. To connect a PC you need a 1:1 connecting cable in which
Pin 2 and Pin 3 are not crossed. Furthermore, Pin 5 GND must be connected. 

NOTICE Please note that the function of the Pins RXD and TXD - input or output - is deter-
mined by the interface type DCE or DTE. The pin assignment for Pin 2 is always
RXD and for Pin 3 it is always TXD.

TAB. 4 PIN ASSIGNMENT: CTRL/DATA INTERFACE

Socket: SUB-D, 9-pole

Pin Signal Electrical characteristics

1 not used PC interface RS232:

Type: DCEa

Level: V.24
Data rate: max. 115200 Baud
Range: max. 15 m
Protocol: 1 start bit

8 data bits
1 stop bit

a DCE = Data Communication Equipment: to connect a PC a 1:1 cable is required

2 RXDb PC RS232 Receive Data

b ATTENTION: on this Pin the Connect Solo transmits data

3 TXDc PC RS232 Transmit Data

c ATTENTION: on this Pin the Connect Solo receives data

4 not used

5 GND Earth

6 not used

7 not used

8 not used

9 not used

5 1

9 6
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A3.2.2 TTL/RELAY interface

Via this interface external control signals can be used.

TAB. 5 PIN ASSIGNMENT: TTL/RELAY INTERFACE (TTL/RELAY)

Socket: SUB-D, 9-pole

Pin Signal Electrical characteristics

1 TTL 1 IN/OUT Capacitance of the TTL outputs:
Maximum voltage: 5V
Maximum current: 10mA

Capacitance of the relays:
Maximum voltage: 48V
Maximum current: 200mA

2 TTL 2IN/OUT

3 TTL 3 IN/OUT

4 TTL 4 IN/OUT

5 GND

6 Relay 1a

7 Relay 1b

8 Relay 2a

9 Relay 2b

5 1

9 6
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A3.3 Audio interfaces

The system incorporates analogue and digital AES/EBU Audio interfaces. For
switching you can use display and keypad or the PC software.

A3.3.1 Analogue Audio interface

A3.3.2 Digital AES/EBU Audio interface

The Connect Solo system incorporates two digital inputs/outputs which are phys-
ically one AES/EBU interface. The input as well as the output has its own sample
rate converter providing that a digital source with 32, 44.1 or 48-kHz can be con-
nected directly. For external clocking (48-kHz only) the word clock input or output
may be used.

TAB. 6 PIN ASSIGNMENT: ANALOGUE INPUT (AUDIO 1/2 IN)

Socket: 3-pole XLR

Pin Signal Electrical characteristics

1 GND Input level: adjustable -3 .... +9 dBu

Impedance: > 25 kΩ

Head room: 6 dB

2 AUDIO IN a

3 AUDIO IN b

TAB. 7 PIN ASSIGNMENT: ANALOGUE OUTPUT (AUDIO 1/2 OUT)

Connector: 3-pole XLR

Pin Signal Electrical characteristics

1 GND Output level: adjustable -3 .... +9 dBu

Impedance: < 50 Ω

Head room: 6 dB

2 AUDIO OUT a

3 AUDIO OUT b

TAB. 8 PIN ASSIGNMENT: DIGITAL INPUT (AES IN)

Socket: 3-pole XLR

Pin Signal Electrical characteristics

1 GND IEC-958

2 AUDIO IN a

3 AUDIO IN b

TAB. 9 PIN ASSIGNMENT: DIGITAL OUTPUT (AES OUT)

Connector: 3-pole XLR

Pin Signal Electrical characteristics

1 GND IEC-958

2 AUDIO OUT a

3 AUDIO OUT b

Push

12

3

21

3

Push

12

3

21

3
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A3.3.3 Power supply interface

The power supply is connected via an external power supply.

TAB. 10 PIN ASSIGNMENT: CLOCK INPUT (CLK IN)

Socket: 3-pole XLR

Pin Signal Electrical characteristics

1 GND TTL

2 CLOCK IN

3 not used

TAB. 11 PIN ASSIGNMENT: CLOCK OUTPUT (CLK OUT)

Connector: 3-pole XLR

Pin Signal Electrical characteristics

1 GND TTL

2 CLOCK OUT

3 not used

TAB. 12 PIN ASSIGNMENT: POWER SUPPLY

Socket: KYCO KPJ-S3

Pin Signal Electrical characteristics

1 GND Voltage: +12V

Power: max. 15W2 +12V

3 not used

Push

12

3

21

3

1 3

2
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A3.4 Cable to connect Connect Solo to Artist CAT5 cards

FIG. 38 CABLE DIAGRAM ARTIST CAT5 CARD TO CONNECT SOLO

A3.5 Cable to connect Connect Solo to AIO 108/109 cards

FIG. 39 CABLE DIAGRAM AIO CARD TO CONNECT SOLO

XLR 3pol female

XLR 3pol male

1
1

RJ45
male

1
2
3

XLR 3pol male

1
2
3
4
5
6
7
8

RxD+
RxD -
TxD+

n.c.
n.c.

TxD -
n.c.
n.c.

1
2
3

XLR 3pol female

XLR 3pol female

XLR 3pol male

1
1

RJ45
male

1
2
3

XLR 3pol male

1
2
3
4
5
6
7
8

TxD+
TxD -
RxD+

Audio In +
Audio In -

RxD -
Audio Out +
Audio Out -

Shield

1
2
3

XLR 3pol female
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A 4 T E C H N I C A L  D A T A

LINE INTERFACES:

– POTS 1 & 2

– 2 x POTS RJ12

Features: Ring Detection
Auto Disconnect
CLIP = Calling Line Identification
Presentation 

TELEPHONE INTERFACES:

– PHONE 1 & 2 for standard POTS telephones for operation

– 2 x PHONES RJ12

CONTROL INTERFACES

– RS232 V.24 9-pol. SUB-D socket

– TTL/RELAY 9-pol. SUB-D socket

– 2 x Relay function can be programmed
Capacitance 48V/200mA

– 4 x TTL Input/Output function can be programmed
Capacitance 5V/10mA

AUDIO INTERFACES

Analogue Audio 1/2:

– Electronic, balanced input XLR female

– Electronic, balanced output XLR male

– Nominal level -3 ... +9 dBu (can be programmed)

– Head room 6 dB

– Impedance Input: > 25 kΩ
Output: < 50 Ω

– Frequency response 300 Hz ... 3400 Hz

– Linearity < 0,2 dB
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– Signal to Noise Ratio < - 90 dB

– Noise < -60 dB

– Crosstalk Audio 1/2 > 60 dB

Digital Audio AES/EBU:

– Format IEC-958 AES/EBU Professional

– Balanced input XLR female

– Balanced output XLR male

– Impedance Input: 110 Ω
Output: 110 Ω

– Clock input TTL/75 Ω XLR female

– Clock output TTL/75 Ω XLR male

– Separate Sample Rate Converter for Input/Output

SIGNAL PROCESSING

– AGC per B channel, configurable

– Echo Canceller per B channel (256 taps, 32 ms Echo Cancel Time)

– Expander per B channel, configurable

DISPLAY

- graphical resolution 160 x 32 Pixel

- illuminated (can be switched off)

POWER SUPPLY VIA EXTERNAL ADAPTER

Direct Voltage (DC)

– + 12 V

Power Consumption

– max. 15 W

DIMENSIONS

H x W x D

– 44 x 220 x 220 mm (1/2 x 19“ x 1U)
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WEIGHT

– ca. 1,7 kg

ADDITIONAL INFORMATION

Approvals

– CE, UL, FCC

EMC

– EN 55103

Electric safety

– EN 60950 

Temperature Range

– +5 °C to 45 °C 

Relative humidity

– 5% to 85% 



PAGE 90 

T e c h n i c a l  D a t a



PAGE 91

G e n e r a l

A 5 G E N E R A L

A5.1 Ordering numbers

Connect Solo (Duo POTS) 1701003

Accessories

CRS-2 19“ Rackmount Set Connect Solo 1701004
for two devices

A5.2 Scope of delivery

– Connect Solo

– CD-ROM with Manual & Windows PC Software

– External power supply with Power Plug Adapter

Input: 100 - 240V/24W, 50 - 60 Hz

Output: 12V

– Self adhesive feet

– 19’’ Mounting Brackets

– 2 x POTS cables

– Quick Guide

A5.3 Declaration of Conformity

You will find the declaration of conformity at the end of this manual.
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A 6 S E R V I C E  I N F O R M A T I O N

A6.1 Software Updates

Software Updates you will find on our Homepage 

A6.2 Support

You can contact our Support Hotline during the normal office hours between
09.00h - 17.00h under the following telephone number:

+49 202 292 90

To deal with your problem efficiently please note the factory number of the unit as
well as the software version that you use.

A6.3 Repairs

If contrary to expectations, your unit is defective please fill in the attached status
report and send the unit to the following address:

Riedel Communications GmbH
- Repairs -
Uellendahler Strasse 353
D-42109 Wuppertal
Germany
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I N D E X

Symbols

.pst 57, 58

Numerics

1 U 15
19 " 19
19" rack 15
19-inch-rack 19
50 Hz 39

A

A/D D/A CONVERTER 1 65
A/D D/A CONVERTER 2 65
ABC 27
About Connect Solo 67
Accepting/dropping calls 20
Accessories 91
adapter 19
Administrator 54, 69
AES/EBU 23, 83
AES/EBU Clock Source 29
AES/EBU Interface 45
AGC 41, 42, 88
AIO 21, 24, 29, 85
Air humidity 19
Alarm 65
All Lines 50, 51
Always closed 51
Always ON 42
Always open 51
Ambient temperature 19
Analogue 21, 23, 24, 45
Artist 29, 85
Audio 1/AES IN 46
Audio 2/CLK IN 45
Audio 2/CLK OUT 46
Audio Input 24, 45
Audio input 24
Audio interface 23
Audio Output 24, 45
Audio settings 23
Auto 42, 43
Auto Disconnect 26

B

Backlight 43

Basic configurations 23
Basic Settings 43
Browse 63

C

Call Out 47
Callin 26
Calling 25, 49, 51
CAT5 21, 24, 29, 85
Channel shifting 25
character 57
Clock 45
Clock input 88
Clock output 88
Clock Source of digital output 45
COM Port 38
COM-Port 31
Configuration 31, 38, 39, 55, 57,

69
Confirm Password 54
Connect 49, 51
Connect Solo 19" Dual Mounting

Kit 15
Connect Solo Software 21, 23
Connecting cable 81
Connection Status 49, 51
contact information 67
Contrast 43
Conventions 14
Crosstalk 88
CSV 36
Cursor keys 27

D

Data Bits 38
Date/Time 28
DCE 81
Deactivation 23
Declaration of Conformity 91, 99
Default Settings 42
DELETE 34
Delete 25, 27, 57
Delete entry 27
Delete Preset 28
Desktop device 19
Digital 23, 24, 45
Dimensions 88
Direction 47
Disconnect 49, 51
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Display 20, 27, 43, 83
Display illumination 23
Download 63
DROP 33
Dropping 25, 26
DSP Load 66
DTE 81
Dual Mounting Kit 15
dynamically 42

E

Earthing 20, 21
Earthing screw 19, 20
Echo Canceller 41, 42, 88
edge change 47
Edit 27, 34, 41, 42, 57
EMC 20, 21, 89
Enable Auto Answer on Audio Line

39
Enable System Ringing Tone 39
Enabled 43
Enter Password 59
Exit 36
Expander 41, 42, 88
Export 33, 58
Export All 58
External 45
External Power Supply 32
External power supply 84
External prefix number 40
Extras 55

F

Factory Number 59
Factory Settings 64
Fast 42
Features 59
Firmware 63
Firmware Version 67
Fixed to High (5V) 49
FLASH EPROM 65
Flash memory 63
Frequency response 87
Front view 15
Function Code 47, 49, 51
Functional elements 17

G

GPIO 47

H

Hardware error 65
Hardware requirements 31
Hardware Version 59
Head room 42, 87

Header 36
Headroom 19, 83
Homepage 93
Hotline 93
Humidity 89
Humming 21, 39

I

IEC-958 88
Impedance 87, 88
Import 57, 58
INFO 32
Input 47
Input field 25
Installation 31
Interface 79
Internal 45

K

Key Tone 43
Keypad 83
Keypad (9600 Baud) 43
keypad lock 43

L

LCA 65
Length of internal telephone num-

bers 40
Level 42
Level In 46
Level indication 25
Level meter 33
Level Out 46
Line 47, 50, 51
Line 1 47
Line echo 42
Line frequency 19
Line Interface 39
Linearity 87
Load 28
Load Preset 48
Login 55, 69

M

MAIN EEPROM 65
Main menu 23, 26, 69
Main Nominal Level 46
Mains voltage 19
Manage Presets 57
Medium 42
Menu 43, 69
Menu structure 23, 69
Minimum requirements 31
Mounting brackets 19
MS EXCEL 36
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N

Name 33
Names 27, 69
Navigation 20
Negative edge 47
New 28, 34, 57
New entry 27
Noise 88
Number 33
Numerical keys 27

O

Off 41, 42
Office hours 93
On 41, 43
Operating buttons 20
Operation 13
Operation settings 69
Operational elements 20
Options 59
Ordering numbers 91
Output 47, 49
OVERHEATED 65

P

Parity 38
Password 54, 59, 69
PBX 40
PC 81
PC (19200 Baud) 38, 43
PC (38400 Baud) 38, 43
PC Offline 32
PC ONLINE 32
PC Online 32
PC ONLINE ALARM 32
PC Software 83
PC Version 67
Phone book 25, 27, 69
Phone Book Entry 53
Phone book entry 27
Phone jack 80
Phone number 25
Port 38
Positive edge 47, 49
POTS 80, 87
POTS 50 Hz Filter 39
POTS interface 80
Power consumption 19
Prefix number 40
Preset 28, 39, 43, 48
Preset menu 28
Presets 28, 55, 57, 69
Private Branch Exchange 40
Progress 63
Putting the system into operation

28

Q

Quick dial 53
QuickBook 28
QuickDial 27, 28
QuickDial number 25
QuickMenu 23

R

Rack 19
Receive 25
Recovered 46
Redialling 27, 33
Registration 59
Relay 82, 87
Relay 1 51
Relay 2 51
Relay output 51
Relays 47
Repairs 93
Resolution 20, 88
RJ12 87
RS232 21, 38, 87

S

Safety 89
Safety instructions 13
Sample Rate Converter 23, 45,

83, 88
Save 28
Save as Quick Dial 27
Scope of delivery 80, 91
Search 27, 33
Select 57
Serial cable 31
Service 62
Set AGC on/off for all lines 41
Set Audio Line 48, 50, 51
Set EC on/off/auto for all lines 42
SHIFT 25, 27
Signal Processing 41
Signal to Noise Ratio 88
Skip prefix number on incoming

call 40
Slow 42
Softkey 20
Software 23, 93
Software Download 63
Software Options 59
Software Updates 93
Software Versions 67
space 57
Speed 42
Standby mode 19
Start 63
Status 49, 51
Status information 69
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Status window 25
Stop Bits 38
Storage 13
Subject Number 59
Support 62, 93
switch current 49
switch voltage 49
synchronous 46
System Alarm 50, 52
System alarm 66
System alarms 65
System Monitor 55, 65
System Panel 62
System settings 23, 69
System Temperature 66
System temperature 19

T

Telephone line 21, 80
Telephone number 93
Telephone receiver button 27
TEMPERATURE SENSOR 65
Threshold 42
Threshold values 19
TIME KEEPER 65
Transmission clock 23
Transmit 25
Transport 13
TTL 47, 49, 51, 82, 87
TTL1 47
TTL2 47
TTL3 47

U

Updates 93
USB Stick 57
User 54, 69
User Rights 54

V

Ventilation 19
Version 67

W

Warm start 60
Warranty claim 19
Weight 89
Wiring 21

Y

Year 59



Supplier’s name: Riedel Communications GmbH

Supplier’s address: Uellendahler Straße 232
D-42109 Wuppertal

declares, that the product

Product name(s): Connect Solo

conforms to the standards of the following European directives:

Number/title: EN 60950 A4 Safety

The conformity is evidenced by strictly meeting the following standards:

Harmonised Standards: EN 55022, EN 55024,
EN 300386,
FCC Part 15 B

Place, date: Wuppertal, 01.06.2006

 
Name: Thomas Riedel

Legally binding signatures:

 
Phone: +49 202 292-90
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